
 Instant Resume Help Contents
The Contents lists the general Help topics available for Instant Resume. When a topic does not fit within one Help 
window, use the scroll bar or PgDn and PgUp to see entries not visible in the window.

To learn how to use Help, press F1 or choose How to Use Help from the Help menu.
Note: Click the Help button in a dialog box to go directly to the help screen for that dialog box.

Instant Resume Help Icons
   Menu/Command    Perform an action

  Keyboard shortcut    See related topic(s)

   Mouse shortcut

  Instant Resume
Overview
Window and Tools
Commands
Keyboard Guide

NOTE: To return to a topic after 
reading a related topic, choose the 
Back button in this Help window

 Instant Resume Overview
Instant Resume automates the process of helping you create professional resumes and manage other tasks 
commonly associated with a job search. It provides special functions that automate the formatting and layout process,
along with many common word processing features.

 See…
Window and Tools
Keyboard Guide



Commands

For information about the commands available in a menu, click the respective menu name.

 See also…
Using Menus
Working with Dialog Boxes



Keyboard Guide

For information about using the keyboard, click the respective topic.

Instant Resume
Using Menus
Working with Dialog Boxes
Working with Text
Menu Shortcut Keys



CLIPBOARD
A temporary storage area in Windows that holds the most recent text (or graphics) placed there with any Windows 
application Cut or Copy command. The clipboard contents can be pasted elsewhere into the same file or into another 
file.



 APPLICATION WINDOW CONTROL MENU (ALT+Spacebar)

Restore
If the window is maximized, the application window becomes small, allowing you access to other active windows.
If the window has been resized, restoring returns the window to its previous size.

Move
Activates the move  cursor, which lets you move the window using the keyboard arrow keys. Move the dotted 
window outline to where you want to position the window and press ENTER.

Size
Lets you resize the window using the keyboard arrow keys. Press the respective arrow key to change the initial 
move cursor to the corresponding size cursor. Then use the arrow keys to move the dotted outline to the size you
want and press ENTER. 

Minimize
Reduces the window to an icon at the bottom of your Windows screen. 

Maximize
Enlarges the window to fill the screen.

Close (ALT+F4)
Closes the window and quits the application.

 Double-click 

Switch To… (CTRL+ESC)
Accesses the Windows Task List dialog box, which lets you switch to another opened application window, and 
other application tasks.
Note:    Refer to your Windows User's Guide for information about using the Task List dialog box.



 DOCUMENT WINDOW CONTROL MENU    (ALT+Hyphen)

Restore
If the window is maximized, the document window becomes small, allowing you access to other active document
windows. If the window has been resized, restoring returns the window to its previous size.

Move
Activates the move  cursor, which lets you move the window using the keyboard arrow keys. Move the dotted 
window outline to where you want to position the window and press ENTER.

Size
Lets you resize the window using the keyboard arrow keys. Press the respective arrow key to change the initial 
move cursor to the corresponding size cursor. Then use the arrow keys to move the dotted outline to the size you
want and press ENTER. 

Minimize
Reduces the window to an icon at the bottom of the Instant Resume application window.

Maximize
Enlarges the window to fill the application window.

Close (CTRL+F4)
Closes the document and window.

 Double-click 

Next (CTRL+F6)
Switches to the next Instant Resume document window or icon.



APPLICATION WINDOW TITLE BAR
Displays the application name. If the active document window is maximized, also displays the name of the active file.



DOCUMENT WINDOW TITLE BAR
Displays the active file's name. When the document window is maximized, the document window's Title Bar is 
removed and the file name then displays in the application window's Title Bar .



Minimize reduces the application window to an icon at the bottom of your Windows screen. 
Maximize enlarges the application window to fill the whole screen.

Once the window is maximized, this button changes to the  Restore button, which lets you shrink the window 
to its previous size.

Double-click the Instant Resume window Title Bar to maximize and restore the window.



Minimize reduces the document window to an icon at the bottom of the Instant Resume application window. 
Maximize enlarges the document window to fill the whole application window.

Once the window is maximized, this button changes to the  Restore button, which lets you shrink the window 
to its previous size.

Double-click the document window Title Bar to maximize its window.



DOCUMENT WINDOW VERTICAL SCROLL BAR

-Click to scroll up, approximately one line

-Click to scroll up one full window

-Drag box to move to an approximate relative location in a file;
e.g., halfway = about halfway through the file

-Click to scroll down one full window

-Click to scroll down, approximately one line

DOCUMENT WINDOW HORIZONTAL SCROLL BAR

Click to scroll right 1 window width
|

|
Click to scroll left 1 window width

Click to scroll left 
Click to scroll right
Drag box to move to an approximate relative horizontal position in a file; e.g., halfway = center of the page



APPLICATION WINDOW VERTICAL SCROLL BAR

-Click to scroll up

-Click to scroll up about one window

-Drag box to move to an approximate relative location in the Instant Resume window
e.g., halfway = about halfway down

-Click to scroll down about one window

-Click to scroll down

APPLICATION WINDOW HORIZONTAL SCROLL BAR

Click to scroll right 1 window width
|

|
Click to scroll left 1 window width

Click to scroll left 
Click to scroll right
Drag box to move to an approximate relative horizontal position in the Instant Resume window; e.g., halfway

= middle of the window



To turn on (select) or off (deselect)
Item                                                On         Off  
Control Strip/Layout Bar buttons

Menu toggle command
Check box option

Option button group



Holding the primary (left) button down as you move the mouse horizontally, vertically, or diagonally.
Note: If you configured the mouse buttons for left-handed use, the right button is your primary mouse button.



Plain text files with no set layout, paragraph, or character formatting.



American National Standards Institute's numeric coding standard for characters and symbols.



What You See (on the screen) Is What You Get (when printed)



Using Menus
Selecting a menu command is easy with the mouse or keyboard. Commands followed by an ellipsis (…) indicate that 
a dialog box will display, which lets you select and specify options for carrying out that command.

   Click the menu name to display its drop-down list of commands. Click on the command you want.
To abort making a selection, click outside the menu, within the application workspace.

Press ALT plus the underlined letter in the menu name; e.g., ALT+F accesses the File menu. Then press the
underlined letter of the command you want.

To abort making a selection, press ESC.

Menu Shortcut Keys
Most Instant Resume menu commands incorporate shortcut keys, letting you quickly activate a command without 
having to access the menu. Shortcut key sequences display to the right of each menu command.
As you become familiar with Instant Resume, use shortcut keys to quickly access those commands you use most 
often.
For a listing of all the menu shortcut keys, click on  Instant Resume

Menu Help
You can easily access the Help system for information about all the commands in a specific menu. 

   Open the appropriate menu and click on the command for which you want help. Press F1.

Press ALT and the underscored letter to open a menu, use the Up and Down arrows to highlight the 
command for which you want help. Press F1.

 See also…
Working with Dialog Boxes
Working with Text



Working with Dialog Boxes
Dialog boxes are one of the primary ways for you to specify settings and select options for carrying out commands in 
a Windows application. The controls commonly available in a dialog box are illustrated below.

Aside from pressing TAB or SHIFT+TAB to navigate between controls, you can quickly jump to a specific 
control by pressing ALT plus the respective underlined character.
To learn how to change settings and options, click on the part of the dialog box below you want to know about.

 

 See also…
Using Menus
Working with Text



 DIALOG BOX CONTROL MENU (ALT+Spacebar)

The Control menu for dialog boxes lets you use the keyboard to move or close the dialog box.
Move

Activates the move  cursor, which lets you move the dialog box using the keyboard arrow keys. Move the 
dotted window outline to where you want to position the dialog box and press ENTER.

Close (ALT+F4 or ESC)
Closes the dialog box and aborts the command and/or unsaved settings.

 Double-click 



Dialog Box Title Bar
Displays the title of the dialog box.

To move a dialog box, click on and drag its Title Bar.



LIST BOX
The currently selected item is highlighted.

   Click to highlight your selection. When there are more items than can fit in the list box, use its vertical scroll bar
to view more options.

TAB to the list box. Use 
 and 
 to highlight your selection and press TAB.

Shortcuts:
First item in list: Home
Last item in list: End
Scroll down: PgDn
Scroll up: PgUp
First word starting with a certain character: Press key
Example: To jump to the first item starting with "m," press m. Then use  to highlight the item you want.



COMBO LIST/TEXT BOX
The text box displays the currently selected item. You can type in your own text/value or select an item from the list 
box as noted below.

   Click to highlight your selection from the list box. When there are more items than can fit in the list box, use its 
vertical scroll bar to view more options.

TAB to highlight the combo text box entry. Use 
 and 
 to highlight your selection from the list box and press TAB.

Shortcuts:
Beginning of text box entry: Home
End of text box entry: End
Scroll down: PgDn
Scroll up: PgUp



DROP-DOWN LIST
The drop-down list's text box displays the currently selected item.

   Click 
 to display the drop-down list. Click to make your selection. When there are more items than can fit in the drop-

down list, use its vertical scroll bar to view more options.
TAB to highlight the drop-down list's text box and press ALT+

 to display the drop-down list. Use 
 and 
 to highlight your selection and press TAB.

Shortcuts:
First item in list: Home
Last item in list: End
Scroll down: PgDn
Scroll up: PgUp
First word starting with a certain character: Press key
Example: To jump to the first item starting with "m," press m. Then use  to highlight the item you want.

Note: If a text cursor is flashing in the text box, you can type in your own text or value for that option.



OPTION BUTTONS
 denotes the currently selected setting. You can make only one selection from each group of option buttons.

   Click on the appropriate option button.

TAB to the currently selected option button. Use 
 or 
 to highlight (dotted outline) your selection from the group and press TAB.



TEXT BOX
A box for text entry and editing.
   Double-click to highlight the text box entry. Edit or type in a new value.

TAB to highlight the text box entry. Edit or type in a new value.
Shortcuts:

Move to beginning of text box entry: Home
Move to end of text box entry: End



CHECK BOXES
Each check box option is a separate feature you can turn on  or off 

. You can turn on any combination of check box options.
   Click to toggle a check box on or off.

TAB to highlight (dotted outline) a check box option. Press Spacebar to toggle it on or off.



COMMAND BUTTONS
The currently selected button is surrounded by a black outline, such as the OK button below.

   Click to execute a button's command.

TAB to select the desired button. Press ENTER to execute its command.
Closes the dialog box and executes the 
command or any setting changes.
Closes the dialog box and aborts the 
command and any changes. (ESC)
Carries out the command noted on the 
button.
Accesses another dialog box, which lets 
you select other related settings and 
options.
Accesses Help for the respective dialog 
box.

Working with Text

Highlighting Text
   Click where you want to begin the selection and drag to highlight the text.

Double-click a word to highlight it.

{ Hold SHIFT down in combination with any of the navigation key(s) to select all the text between the current 
cursor position and the new cursor position.

Click on Navigating Within a Section or Item for the available navigation keys.

Replacing Text
To replace existing text, highlight the text and type in the replacement text.

Note: If you changed the default typing mode in Instant Resume from INS (Insert) to OVR (Overstrike), typing 
automatically replaces any subsequent text. CAUTION: Be careful not to type over existing text you do not want 
to replace.

Adding Text
To add new text, place the text cursor where you want to insert the new text and type your addition.

Note: If you changed the default typing mode in Instant Resume from INS (Insert) to OVR (Overstrike), press 
INS (or INSERT) to return to Insert mode.

Deleting Text
To delete the next character, press DEL (or DELETE).
To delete the previous character, press BACKSPACE.
To delete text, highlight the text and press DEL or BACKSPACE.

Moving Text
To move text, highlight the text and choose Edit/Cut (CTRL+X). The text is copied to the clipboard and removed 

from your resume.
Next, move the text cursor to the place where you want to insert the cut text and choose Edit/Paste (CTRL+V). 
The text is copied from the clipboard and inserted.

Duplicating Text
To duplicate text, highlight the text and choose Edit/Copy (CTRL+C). The text is copied to the clipboard without 

removing it from your resume.
Next, move the text cursor to the place where you want to insert the copied text and choose Edit/Paste 
(CTRL+V). The duplicated text is copied from the clipboard and inserted.

Note: Only the contents of the last Cut or Copy you do remains on the clipboard.



 See also…
Using Menus
Working with Dialog Boxes



Edit Menu: Text Editing Commands
Use the Edit menu text editing commands to remove, copy, and insert text in your resume.

Undo (CTRL+Z)
Reverses the last Edit, Format, Contact, Calendar, or Utilities command or action. When a command or action
is irreversible, this command changes to the dimmed Can't Undo.

To reverse an Undo and redo your last action, choose Edit/Redo.
Cut (CTRL+X)

Removes selected text and places it on the clipboard.

Copy (CTRL+C)
Places a duplicate of selected text on the clipboard.

Paste (CTRL+V)
Inserts from the clipboard, at the current cursor position, the last copied (Copy) or cut (Cut) text.



View Menu: Toggle Commands
Use the View menu toggle commands to control which tool and information strips display in the Instant Resume 
application window. A check mark next to a command indicates that it is selected.

Show Layout Bar (ALT+SHIFT+L)
Turns the display of Instant Resume's Layout Bar on or off.

Show Control Strip (ALT+SHIFT+C)
Turns the display of the Control Strip on or off.

Show Status Strip (ALT+SHIFT+S)
Turns the display of the Status Strip on or off.

Show QuickButtons  (ALT+SHIFT+Q)
Turns the display of QuickButtons on or off.



QuickButtons

Show/Hide  ALT+SHIFT+Q

Instant Resume's QuickButtons let you use the mouse to quickly access commonly used commands via a 
customizable strip or palette of buttons. QuickButtons are initially hidden. When shown, they initially display under the
menu bar. The default set of commands are described below.

1 File Commands

New... Accesses the New dialog box, which lets you create a new resume.

Open… Accesses the Open dialog box, which lets you open an existing resume.

Save Saves the active window's file using its current name, directory, and drive. If it is the first time you 
are saving a resume, the Save As dialog box, which lets you specify the file name for your [Untitled] resume, is 
accessed.

To save an already-named file to a different name, drive, and/or directory, use the Save 
As… (F12) command.

Print… Accesses the respective Print dialog box, which lets you choose options for printing your file to the 
printer selected with the Printer Setup… (CTRL+Q) command.

2 Edit Commands

Undo/Redo If possible, this command reverses the last Edit, Format, Contact, Calendar, or Utilities 
command or action.

To reverse an Undo and redo your last action, choose this button again.

Cut Removes selected text and places it on the clipboard.

Copy Places a duplicate of the selected text on the clipboard.

Paste Inserts from the clipboard, at the current cursor position, the last copied (Copy) or cut (Cut) text.
 See also…

Customize QuickButtons



Customize QuickButtons Dialog Box
 Utilities/Customize QuickButtons… (ALT+U,Q)  

 CTRL+SHIFT+Q
Double-click any blank area on the QuickButtons strip to access the Customize QuickButtons dialog box. 

When QuickButtons are a floating palette, double-click on the Title Bar.
This dialog box lets you add and delete commands to and from QuickButtons, and change their position on your 
screen.

The box on the left lists all the commands that can be included as QuickButtons.
To add a command, select the command and click Add. This button is dimmed if the selected command has 

already been added.
To add all the commands, click Add All. This button is dimmed if all commands are already added.
To remove a command, select the command and click Remove. This button is dimmed if the selected command 

was not previously added.
To remove all the commands, click Remove All. This button is dimmed if there are no QuickButtons to remove.
To reset QuickButtons to include the default set of commands, click Default.

To Position… Choose…
Horizontally, beneath 
the menu bar

Top 
(default 
position)

Horizontally, above 
the status strip

Bottom

Vertically, on the left 
side beneath the 
control strip 

Left

Vertically, on the right
side beneath the 
control strip 

Right

As a separate palette
that can be moved 
anywhere within the 
application window

Floating

To move a floating QuickButtons palette, drag its Title Bar.
Click Close to save the settings.



Window Menu
Use the Window menu commands to arrange document windows and icons on your screen, as well as to quickly 
access any opened Instant Resume file.

Cascade
Arranges all open document windows in an overlapping fashion so that the title bar of each window remains 
visible with the active window on top.

Tile
Arranges all open document windows in non-overlapping "tiles" so that all windows are visible.

Arrange Icons
Arranges the icons for minimized document windows in a row at the bottom of the Instant Resume window, 
starting from the lower left corner.

Close All
Closes all open document windows. If you made any unsaved changes to a file, Instant Resume asks if you wish
to save before closing.

1 filename.rsm
2 filename.rsm
etc.

These commands list all your open and minimized Instant Resume document windows.
If there are no opened files, file names are noted as '[Untitled #],' where '#' is a sequentially assigned number for 
each file that hasn't been saved.
The document window you select from this list becomes the active window and is then marked with a check 
mark. If the document is minimized, it is restored to its former size and position.



Help Menu
Use the Help menu commands to access the Instant Resume Help system.

Index
Lets you select from a listing of main topics for which help is available. To get help for any topic in the list, select 
it by either clicking it with your mouse or press TAB until the desired topic is highlighted, then press ENTER.

Commands
Lets you get help with menu commands. When you choose Commands, the Commands screen appears. This 
screen displays all the Instant Resume menus. When you select a menu name from the menu bar, Instant 
Resume displays information about each command in that menu.

Keyboard
Lets you get help with using the keyboard and keyboard shortcuts. When you choose Keyboard, the Keyboard 
Guide screen displays. Select a topic from the list by either clicking it with your mouse or using TAB to highlight it 
and pressing ENTER.

Using Help
Displays Microsoft's instructions for using Windows help systems.

About Instant Resume…
Displays information about the version of Instant Resume you are using.



Commands and Tools
When you create a new resume, a copy of the template's contents displays in the document window.

Click the part of the Instant Resume window you want to know about.

 See also…
Using Menus
Working with Dialog Boxes



Control Strip

Show/Hide  ALT+SHIFT+C

The Instant Resume Control Strip lets you use the mouse to quickly access commonly used commands via drop-
down lists and buttons. Selected buttons are pressed (highlighted).
Note: Format changes stay in effect unless you subsequently modify the Section Character or Section Paragraph 
settings for the section(s) to which you are applying a new format.

1 Format/Character Commands

 Font Lets you choose a different typeface to apply to any selected or new text.
       Point Size Lets you choose a different character size to apply to any selected or new text.

Character Styles (can select any combination of the three styles)

Bold Applies bold style to any new text you type. If text is selected, toggles bold on or off.

Italic Applies italic style to any new text you type. If text is selected, toggles italic on or off.

Underline Applies underline style to any new text you type. If text is selected, toggles underline on or
off.

2 Format/Paragraph Commands (can select only one of the four alignments for any one paragraph)

Left Aligns selected and new paragraphs with the left margin, creating a ragged right edge.

Right Aligns selected and new paragraphs with the right margin, creating a ragged left edge.

Center Centers each line in selected and new paragraphs between the left and right margins, creating 
ragged edges on both sides.

Justify Adjusts spacing between words in selected and new paragraphs so that the lines are flush with 
both the left and right margins.

3 Resume Format Variations (can select only one of the eight buttons)
Each Resume Format button represents a miniature sketch of different layouts you can use for the entire 
resume.

#1 This button is the default resume format, as determined by the resume template.
#2-#8 Other resume formats you can choose.



Layout Bar

Show/Hide  ALT+SHIFT+L

The Instant Resume Layout Bar lets you use the mouse to quickly change the style and format of the current resume 
section by applying one of the built-in automatic section formats. 
Note: Choosing a different section layout does not affect the overall resume format selected on the Control Strip.

The number of available section layout variations for any particular section is determined by the resume's template 
and on the current text cursor position. As you move the cursor around the resume, the Layout Bar buttons change to
reflect the layouts available for the current section. Each Layout Bar button is an iconic representation of a different 
layout. The active layout for the current section is depressed.

To apply a different layout to the current section, just click on the Layout Bar button you want.
By default, the Layout Bar displays at the top of the Instant Resume window. To change the location of the Bar, see 
the Position Layout Bar... command and dialog box.



Status Strip

Show/Hide  ALT+SHIFT+S

The Instant Resume Status Strip displays general information about the current resume.
1 Message bar

Displays a brief explanation of each menu or command you select via the keyboard or mouse. Also displays a 
brief explanation of the QuickButtons or Control Strip tool your mouse pointer is on top of.

2 Page Number
Displays the current page number and the total number of pages in your resume.

3 Typing Mode
Indicates whether you are in Insert (default) or Overstrike typing mode.

INS = inserts the text you are typing at the current cursor position, pushing any existing text to the right
OVR = replaces existing text with the text you are typing

To switch between typing modes, press INS (or INSERT).



Editing Your Resume
The Instant Resume editing area displays the resume's contents. If the current resume is a new one, its template's 
contents display. Each template item contains place holder text that helps guide you in creating your resume. Where 
necessary, replace each item with your own information.

Click on the part of the resume template you want to know about.

Navigating Around The Resume

  
Click to jump to another part within the document 
window.
Use vertical and/or horizontal scroll bars as needed.

Next item TAB
Previous item SHIFT+TAB
Item above CTRL+
Item below CTRL+
Beginning of resume CTRL+Home,Home
End of resume CTRL+End,End
Top section in window CTRL+PgUp
Bottom section in window CTRL+PgDn
Down one screen PgDn
Up one screen PgUp

Navigating Within a Section or Component

  
Click where you want the text cursor.

Beginning of section CTRL+Home
End of section CTRL+End
Beginning of item Home
End of item End
Next character
Previous character
Next word CTRL+
Previous word CTRL+
Next line
Previous line

 See also…
Adding, Deleting, and Rearranging Sections and Subsections



Working with Text



The currently selected and active section or subsection is enclosed within a gray box border. 



The currently active item's text is entirely highlighted when you TAB or SHIFT+TAB to move between 
resume items.



Some sections, such as Objective, consist of only descriptive text and have no subsections. 



The title of a section that contains subsections. 



A subsection of a section. 



Adding, Deleting, and Rearranging Sections and Subsections

Adding
To add a new section or subsection, choose Edit/Add Section... (CTRL+A) to access the Add Section dialog box.

Note: To insert a new subsection right after the section header, place the text cursor within the section header 
line before accessing this command.
To insert a subsection between existing subsections, place the text cursor in the subsection you want the new 
subsection to follow.

Deleting
To delete a section or subsection, move the text cursor to that item and choose Edit/Delete (Sub)section... 

(CTRL+D) to access the Delete (Sub)Section confirmation box.
 If a section heading is selected (e.g., Experience), the entire section and all its subsections are removed.
 If a selected subsection is the only item under that section, the entire section is removed.
 If a selected subsection is not the only item under that section, only that subsection is removed.

Rearranging
Rearranging sections, and subsections within a section, is easily accomplished by dragging the selected section or 
subsection.

 When you move a section, all its subsections also move.
 You can move a subsection only within its respective section.

Move the mouse cursor into the left margin; the text cursor becomes the move  cursor.
To select a section to move, click the move cursor to the left of the section's title; e.g., Experience.
To select a subsection to move, click the move cursor to the left of the subsection.

The selected resume item is enclosed within a gray box border.

To move the selected item, drag    
 up or down until the horizontal black line is where you want to insert the moved section or subsection. Release the 

mouse.
 See also…

Working with Text



File Menu
Use the File menu commands to create, open, save, close, and print your resume. This menu also contains the 
commands for changing the orientation, paper size, margins, and printers, and for exiting Instant Resume.

New… (CTRL+N)
Accesses the New dialog box, which allows you to select a template and create a new resume.

Open… (CTRL+O)
Accesses the Open dialog box, which lets you open an existing resume.

Close (CTRL+F4)
Closes the current resume. If there are any unsaved changes, or if you have not saved the file, Instant Resume 
will ask if you wish to save.

Save (CTRL+S)
Saves the current window's file using its current name, directory, and drive. If this is the first time you are saving 
the resume, the Save As dialog box appears. This dialog box lets you specify the file name and location for your 
resume. To save an already-named file to a different name, drive, directory, and/or file format, use the Save As…
(F12) command (see below).

Save As… (F12)
Accesses the respective Save    As dialog box, which lets you name an [Untitled] resume, or save an already-
named file to a different name, drive, and/or directory, or save your resume as an    ASCII text file format.

Page Setup… (CTRL+W)
Accesses the Page Setup dialog box, which lets you change the orientation, paper size, and margins to use for 
printing your resume.

Print… (CTRL+P)
Accesses the Print dialog box, which lets you choose options for printing your resume to the printer selected with
the Printer Setup… (CTRL+Q) command (see below).

Printer Setup… (CTRL+Q)
Accesses the Printer Setup dialog box, which lets you choose the printer to use for printing your resumes.

Exit Instant Resume (ALT+F4)
Closes all open files and exits the Instant Resume program. If there are any unsaved changes, Instant Resume 
will ask if you wish to save those files.



New Dialog Box
 File/New… (ALT+F,N)  

 CTRL+N
This dialog box lets you choose the template you want to use for the new resume.

When creating a new resume, you must select a template on which to base your resume.
To select a template, choose from the Resume Template list box; the default sections included in the 
selected template are listed in the Default Headings box.

By default, Instant Resume creates a new resume in the active document window. If a file is already opened in the 
respective window and you have made changes, Instant Resume asks if you wish to save before closing that file.

To display the new resume in a new document window, click the New Window check box.
Note: The number of document windows that can be opened simultaneously is limited only by the amount of memory
available on your computer.

Click OK to display the new [Untitled] resume.



Open Dialog Box
 File/Open… (ALT+F,O)  

 CTRL+O
This dialog box lets you choose an existing file to open. 

All files with the respective extension are listed in the File Name list box.

If the file you want is not listed, change to the drive and/or directory where you saved your files.
To change to a different drive, click the Drives 
 and choose from the drop-down list.
To change to a different directory on the current drive, choose from the Directories list box by double-clicking on 

the desired directory.
To select which file to open, choose from the File Name list box; the name displays in the text box.

By default, Instant Resume opens a file in the active document window. If a file is already opened in that window and 
you have made changes, Instant Resume asks if you wish to save before closing that file.

To open a resume in a new document window, click the New Window check box.
Note: The number document windows that can be opened simultaneously is limited only by the amount of memory 
available on your computer. 

Click OK or press ENTER to display the file in a document window.
Double-click on the file name to open the file.



Close
 File/Close (ALT+F,C)  

 CTRL+F4
 Double-click document window 

This command closes the currently active file and document window. If you have any unsaved changes, Instant 
Resume will ask if you wish to save them.



Save
 File/Save (ALT+F,S)  

 CTRL+S
This command saves the current file using its current name, directory, and drive. If it is the first time you are saving a 
resume, this command accesses the Save As dialog box, which lets you specify the file name for your [Untitled] 
resume.
To save an already-named file to a different name, drive, and/or directory, use the Save As… (F12) command.



Save As Dialog Box
 File/Save As… (ALT+F,A)  

 F12
This dialog box lets you specify a name for an [Untitled] resume, or save the current resume to a different file name, 
drive, and/or directory.

Save Resume As
The List Files of Type box automatically displays the file formats in which you can save a resume, 'Resume (*.RSM) 
and ASCII (*.TXT).'

If needed, change to the drive and directory where you want to save the file.
To change to a different drive, click the Drives 
 and choose from the drop-down list.
To change to a different directory on the current drive, choose from the Directories list box by double-clicking on 

the desired directory.
To specify the new name, press ALT+F or click within the File Name text box. Type in the new name (up to 8 

characters, no spaces).
Click OK or press ENTER. The file's new name displays in the Title Bar.



Page Setup Dialog Box
 File/Page Setup… (ALT+F,T)  

 CTRL+W
This dialog box lets you set the file's orientation, paper size, and margins.

To change the Orientation, click the alternate 
.

Note: Resumes should always be printed in Portrait (default).

To use a different Paper Size, click 
 to choose from the drop-down list.

If you choose Custom, enter the dimensions in the Width and Height text boxes.

Refer to your printer manual for its maximum allowable paper size.
Note: Resumes and letters should always be printed on 'Letter 8.5 x 11 in' (default) size paper.

To change Margins, type a new value in the respective text box.
Click OK or press ENTER to save your settings.
IMPORTANT: If you change the orientation and/or paper size, you must also change these two settings via the 
Printer Setup dialog box.



Print Dialog Box
 File/Print… (ALT+F,P)  

 CTRL+P
This dialog box lets you choose options for printing the active resume.

The Printer field displays the name and port of the active printer.

To print more than one copy, change the default '1' value in the Copies text box accordingly.
By default, Instant Resume prints the entire resume (All).

To print only a selected range of Pages, click Range and enter the starting and ending page numbers in the From 
and To text boxes.

To print the file to disk instead of the printer, click the Print To File check box. This option is useful if you want to 
bring your file to another computer which is connected to a higher-quality printer; however, you must remember to 
select that printer from the Printer Setup dialog box.
Click OK or press ENTER to print.

If you checked the Print To File option, the Print To File dialog box displays, which lets you specify a name for the 
print file.

Refer to your DOS manual for information about using the Copy /b command to send the print file to the 
printer.

 See…
Printer Setup to change the active printer



Printer Setup Dialog Box
 File/Printer Setup… (ALT+F,R)
 CTRL+Q

This dialog box lets you choose the printer to use for printing your files and lets you change the selected printer's 
default settings.

Instant Resume uses the default printer specified in the Windows Control Panel unless you choose another printer. 
The selected printer should be the one on which you plan to print the final copy of your Instant Resume files.

To print to a different printer, select the printer.
IMPORTANT: If you changed the orientation and/or paper size in the Page Setup dialog box, you must also change 
these two settings via the Setup… button.

To change the selected printer's default settings, click Setup…. Make sure the orientation and paper size coincide 
with those selected in the Page Setup dialog box.

Refer to your Windows User's Guide and printer manual for information about other settings for your 
particular printer.



Windows utility for setting up the Windows environment and peripherals, including printers.



Exit Instant Resume
 File/Exit (ALT+F,X)  

 ALT+F4
 Double-click the application window 

This command closes all open files and exits the Instant Resume program. If there are any unsaved changes, Instant 
Resume will ask if you wish to save them.



TEMPLATE

A prebuilt framework that provides preset text, text place holders, character formatting, paragraph formatting, and 
page layout information for a resume.



The direction in which to print a file.

 Portrait / Vertical

Landscape / Horizontal



Amount of blank (non-printable) space to leave on each side of the page.



Type the path and name for the print file. Print files are not automatically assigned extensions. If you want an 
extension, such as .PRN, you must enter it manually.
Click OK to create the print file.



Edit Menu
Use the Edit menu commands to remove, copy, insert, find, and replace text in your resume and to add and delete 
resume sections. This menu also contains the commands for inserting header text and page numbers on subsequent 
pages when your resume is longer than one page.

Undo/Redo (CTRL+Z)
Reverses the last Edit, Format, or Utilities command or action. When a command or action is irreversible, this 
command changes to the dimmed Can't Undo.

To reverse an Undo and redo your last action, choose Edit/Redo.
Cut (CTRL+X)

Removes selected text and places it on the clipboard.

Copy (CTRL+C)
Places a duplicate of selected text on the clipboard.

Paste (CTRL+V)
Inserts from the clipboard, at the current cursor position, the last copied (Copy) or cut (Cut) text.

Find… (F7)
Searches the resume, from the current cursor position, for text you specify via the Find dialog box.

Replace… (F8)
Searches the resume, from the current cursor position, for text you specify via the Replace dialog box, giving you
the option to replace that text with new text.

Find Next/Replace Next… (F3)
Repeats the last Find or Replace.

 Find Next searches for the next occurrence of the previously specified text.
 Replace Next… accesses the Replace dialog box with the previously specified Find and Replace With text.

Add Section… (CTRL+A)
Accesses the Add Section dialog box, which lets you insert a completely new section in the current resume or 
add another subsection to an existing section.

Delete Section/Delete Subsection… (CTRL+D)
Displays the Delete (Sub)Section confirmation box, which asks you to confirm removing the currently selected 
section or subsection from your resume.

Insert Header (ALT+SHIFT+H)
When a resume is longer than one page, this command creates a header on all subsequent pages with your 
name (as entered on the first line of the template) and page number.
Once you insert a header, this command changes to Go To Header, which lets you manually edit the default 
contents and format of the header. Changes you make to the header are reflected on all pages after the first 
page.
  To edit, click within the header line.

Insert Page Number (ALT+SHIFT+I)
Inserts the page number in the resume header at the current cursor position.
Note: This command is available only when the text cursor is within the header.



Find Dialog Box
 Edit/Find… (ALT+E,F)  

 F7
This dialog box lets you search the current resume for text you specify.

Specifying Text and Options
To specify the text you want to find, type the word(s) in the Find text box.

By default, Instant Resume searches forward from the current cursor position only for those occurrences that match 
or begin with your specified text exactly as you typed it, regardless of whether or not the specified text is part of a 
word or phrase.

To search backwards through the resume, check the Backwards option.
To locate all occurrences of the specified text, regardless of whether they appear in upper and/or lower case, check

the Ignore Case option.
To locate only those occurrences when the specified text consists of whole word(s), check the Whole Word option.

Find Commands
Click OK to display the first occurrence of the specified text. If no occurrences exist, a message box displays.

This button then changes to the Find Next command. Click to search for the next occurrence of the specified 
text. If no more occurrences exist, a message box informs you of that fact.

Click Replace to switch to the Replace dialog box, which gives you the option of replacing the specified text with new 
text.
Click Done to stop searching and close the dialog box.

Note: Choose Edit/Find Next, or press F3, to repeat the last Find.



 
Click OK to close the message box.



Replace Dialog Box
 Edit/Replace… (ALT+E,R)  

 F8
This dialog box lets you search the current resume from the current cursor position for text you specify, with the 
option of replacing it with new text.

Specifying Text
To specify the text you want to find, type the word(s) in the Find text box.

By default, Instant Resume searches for those occurrences that match or begin with your specified text exactly as 
you typed it, regardless of whether or not the specified text is part of a word or phrase.

To locate all occurrences of the specified text, regardless of whether they appear in upper and/or lower case, check
the Ignore Case option.

To locate only those occurrences when the specified text consists of whole word(s), check the Whole Word option.
Replace Commands
Click Start to display the first occurrence of the specified Find text. If no occurrences exist, a message box displays.

This button then changes to the Skip command. Click to search for the next occurrence of the specified Find text
without replacing the current occurrence. If no more occurrences exist, a message box informs you of that fact.

Click Replace to replace the current occurrence of the specified Find text with the new Replace With text and to 
continue searching for the next occurrence of the specified Find text.

If no more occurrences exist, a message box informs you of that fact.
Click Replace All to automatically replace all remaining occurrences of the specified Find text with the new Replace 
With text.
Click Done to stop searching and close the dialog box.

Note: Choose Edit/Replace Next..., or press F3, to repeat the last Replace.



Add Section Dialog Box
 Edit/Add Section… (ALT+E,A)  

 CTRL+A
This dialog box lets you insert a new section into the current resume or add another subsection to an existing section.

The Section Type box lists all the sections you can include in the current resume. This list varies according to the 
resume's template and the sections you have already added. If an existing section cannot have subsections, such as 
Name/Address, that section is not listed.

Depending on the Section Type you choose, Instant Resume will respond in one of two ways.
 If the section is not in the resume, the section is inserted at a predetermined position.
 If the section already exists in the resume, another subsection is added to that section.
If the text cursor is within the selected section, the added subsection is inserted after the current subsection.
If the text cursor is in a different section, the added subsection is inserted at the end of its proper section.

Click OK or press ENTER to add the section or subsection.
 See also…

Editing your resume



Delete Section/Delete Subsection Confirmation Box
This box asks you to confirm removing the current section or subsection.

Click OK or press ENTER to remove the selected section or subsection.
Click Cancel or press ESC to return to the resume without deleting.

 If a section heading is selected (e.g., Experience), the entire section and all its subsections are removed.
 If a selected subsection is the only item under that section, the entire section is removed.
 If a selected subsection is not the only item under that section, only that subsection is removed.



View Menu
Use the View menu commands to control what is displayed in the Instant Resume application window and the size at 
which the current resume displays. A check mark next to a command indicates that it is selected.

Actual Size (CTRL+1)
Displays the resume at its approximate size when printed.

Fit Page In Window (CTRL+9)
Scales the resume display to fit the entire page in the document window.

Fit Margins In Window (CTRL+8)
Scales the resume display so that only the space within the left and right margins displays.

200% (CTRL+2)
Displays the resume at twice its actual size.

75% (CTRL+7)
Displays the resume at three-quarters its actual size.

50% (CTRL+5)
Displays the resume at half its actual size.

Show Layout Bar (ALT+SHIFT+L)
Turns the display of Instant Resume's Layout Bar on or off.

Show Control Strip (ALT+SHIFT+C)
Turns the display of the Control Strip on or off.

Show Status Strip (ALT+SHIFT+S)
Turns the display of the Status Strip on or off.

Show QuickButtons  (ALT+SHIFT+Q)
Turns the display of the QuickButtons on or off.



Format Menu
Use the Format menu commands to control the formatting of your resume to redefine or override default character 
and/or paragraph format settings. A check mark next to a command indicates that it is selected.
Note: The last character and paragraph settings you apply with Instant Resume's Control Strip or set with the 
Character… and Paragraph… commands remain in effect for the selected Layout Bar style until you subsequently 
choose a different Layout Bar style or modify the character or paragraph settings from this menu.

Global Character… (CTRL+G)
Accesses the Global Character dialog box, which lets you customize the default character attributes of elements 
common to the entire resume.

Section Character… (CTRL+H)
Accesses the Section Character dialog box, which lets you modify the character attributes that are reflected 
throughout the current section in the resume.

Section Paragraph… (CTRL+SHIFT+H)
Accesses the Section Paragraph dialog box, which lets you modify the paragraph attributes that are reflected 
throughout the current section in the resume.

Character… (CTRL+SHIFT+C)
Accesses the Character dialog box, which lets you override default character attributes for selected text or for 
new text you type.

 Bold (CTRL+B)
Applies bold style to any new text you type. If text is selected, toggles bold on or off.

 Italic (CTRL+I)
Applies italic style to any new text you type. If text is selected, toggles italic on or off.

 Underline (CTRL+U)
Applies underline style to any new text you type. If text is selected, toggles underline on or off.

Paragraph… (CTRL+SHIFT+P)
Accesses the Paragraph dialog box, which lets you override default paragraph attributes for the current 
paragraph, selected paragraphs, or any new paragraph you create.

 Left (CTRL+L)
Aligns selected and new paragraphs with the left margin, creating a ragged right edge. If no paragraph is 
selected, aligns the current paragraph.

 Right (CTRL+R)
Aligns selected and new paragraphs with the right margin, creating a ragged left edge. If no paragraph is 
selected, aligns the current paragraph.

 Center (CTRL+M)
Centers each line in selected and new paragraphs between the left and right margins, creating ragged edges on 
both sides. If no paragraph is selected, centers the current paragraph.

 Justify (CTRL+J)
Adjusts spacing between words in selected and new paragraphs so that the paragraphs are flush with both the 
left and right margins. If no paragraph is selected, justifies the current paragraph.

Insert Page Break (CTRL+ENTER)
Starts a new page before the current subsection or section in a resume.
This command changes to Delete Page Break when you place the cursor in the first subsection or section after 
a page break. Deleting a page break rejoins the current page's contents with the previous page.



Font, point size, and character styles



Indents, spacing, alignment, hyphenation, borders, bullets, and/or tabs



Global Character Dialog Box
 Format/Global Character… (ALT+O,G)  

 CTRL+G
This dialog box lets you view and customize the default character attributes of elements common to the entire 
resume. Global character attributes are common to all templates. 
EXAMPLE:

Headings
affects the titles of every section.

Date
affects the date fields throughout the resume. 

Body Text
affects all other text.

Global Character Attributes
To select the resume item whose character attributes you want to view or modify, click the Global Character Item 
 to choose from the list.

Font specifies the typeface used for the selected resume item. The type of font (i.e., True Type, Type 1, Bitmap) is 
noted under the Sample display box. (If more than one font is selected for the item, the text box appears blank.)
Point Size specifies the size of the font used for the selected resume item. (If more than one point size is assigned to
the item, the text box appears blank.)
Style reflects the combination of styles used for the selected resume item: bold, italic, underlined, and/or all upper 
case text. (If a style option is applied to some of the item's text, the check box appears shaded.)
Sample displays a WYSIWYG sample of the selected resume item's character attributes.

Global Character Options and Commands
To modify the character attributes for the selected resume item, choose a different font , choose or type in a 

different point size (4-127), or click to toggle any combination of the styles on or off. The Sample display automatically
reflects any changes.
Click Save to save changes made to the selected resume item.

If you choose another Global Character Item without saving any changes, a message box will ask if you wish to
save the changes.

Click Apply To All Layouts if you want the attributes that are set for the current resume item to be reflected in all the 
resume format buttons on the Control Strip.
Click Default to discard all changes made to the currently selected resume item and return its attributes to the 
original resume template settings.
Click Close after you finish making all the changes you want. If there are any unsaved changes, a message box asks
if you wish to save the changes.

This command initially appears as Cancel, changing to Close only if you save changes to a resume item.



Section Character Dialog Box
 Format/Section Character… (ALT+O,S)  

 CTRL+H
This dialog box lets you view and customize the default character attributes of elements common to the current 
resume section (where the text cursor is located). The elements available vary according to the particular section. 
Changes made to a section item are reflected throughout the current section.

Section Character Attributes
To select the section item whose character attributes you want to view or modify, click the (Section Name) Item 
 to choose from the list.

Font specifies the typeface used for the selected section item. The type of font (i.e., True Type, Type 1, Bitmap) is 
noted under the Sample display box. (If more than one font is selected for the item, the text box appears blank.)
Point Size specifies the size of the font used for the selected section item. (If more than one point size is assigned to 
the item, the text box appears blank.)
Style reflects the combination of styles used for the selected section item: bold, italic, underlined, and/or all upper 
case text. (If a style option is applied to some of the item's text, the check box appears shaded.)
Sample displays a WYSIWYG sample of the selected section item's character attributes.

Section Character Options and Commands
To modify the character attributes for the selected section item, choose a different font, choose or type in a different

point size (4-127), or click to toggle any combination of the styles on or off. The Sample display automatically reflects 
any changes.
Click Save to save changes made to the selected section item.

If you choose another (Section Name) Item without saving any changes, a message box will ask if you wish to 
save the changes.

Click Apply To All Layouts if you want the character attributes that are set for the current section item to be reflected
in all the respective Layout Bar formats.
Click Default to discard all changes made to the currently selected section item and return its character attributes to 
the original resume template settings.
Click Close after you finish making all the changes you want. If there are any unsaved changes, a message box asks
if you wish to save the changes.

This command initially appears as Cancel, changing to Close only if you save any changes to a section item.



Section Paragraph Dialog Box
 Format/Section Paragraph… (ALT+O,E)  

 CTRL+SHIFT+H
This dialog box lets you view and customize the default paragraph attributes of elements common to the current 
resume section (where the text cursor is located). The elements available vary according to the particular section. 
Changes made to a section item are reflected throughout the current section.

Section Paragraph Attributes
To select the section item whose paragraph attributes you want to view or modify, click the (Section Name) Item 
 to choose from the list.

Indents dictate the amount of horizontal space to indent the selected section item paragraph(s), in relation to the left 
or right margin. A zero indent means that the text is aligned with the margins.

Left amount of space to indent the left side of the paragraph(s) from the left margin.
Right amount of space to indent the right side of the paragraph(s) from the right margin.

First amount of space to indent the first line of the paragraph(s) from the left indent.
Spacing dictates the amount of vertical space to use before and after paragraph(s) and the space to use between 
the lines in every paragraph.

Above amount of space to add before the first line of paragraph(s).
Below amount of space to add after the last line of paragraph(s).
Leading amount of space to use between lines of text in each paragraph, specified as a percentage of the nominal 
line spacing (e.g., 100 = normal; 200 = double-spaced).

Note: You can choose a Leading value from its drop-down list or type in your own percentage (values from 
50 to 300 percent are valid).

Alignment determines how to align all paragraphs in the selected section item.

Left
aligns text with the left margin, creating a ragged right edge.

Right
aligns text with the right margin, creating a ragged left edge.

Center
centers each line between the left and right margins, creating ragged edges on both sides.

Justify
adjusts spacing between words so that the paragraph(s) are flush with both the left and right margins.

To avoid large amounts of white space between words in narrow columns, turn hyphenation on (see below).
Hyphenation determines if and how often the selected section item paragraph(s) use automatic hyphenation.

None turns automatic hyphenation off (default); no lines are automatically hyphenated.
Adjacent Lines every line can be hyphenated.
2 Line Separation every other line can be hyphenated.

3 Line Separation every third line can be hyphenated.

Section Paragraph Options and Commands
To modify the paragraph attributes for the selected section item, type in a different value in any of the Indent or 

Spacing text boxes, choose a different Alignment, and/or choose another Hyphenation setting.

To create a hanging indent (first line is closer to or at the left margin), enter a negative value in the First text box; 
enter a greater than or equal to positive number in the Left text box.

To select paragraph bullet options for the selected section item, click Bullet... to access the Bullet dialog box.
Click Save to save changes made to the selected section item.

If you choose another (Section Name) Item without saving any changes, a message box will ask if you wish to 
save the changes.

Click Default to discard all changes made to the currently selected section item and return its paragraph attributes to 
the original resume template settings.



Click Close after you finish making all the changes you want. If there are any unsaved changes, a message box asks
if you wish to save the changes.

This command initially appears as Cancel, changing to Close only if you save changes to a section item.



Character Dialog Box
 Format/Character… (ALT+O,C)  

 CTRL+SHIFT+C
This dialog box lets you modify the character attributes for selected text, or set the character attributes for text you 
are about to enter.
Sample displays a WYSIWYG sample of the selected character attributes. The display automatically redraws to 
reflect any changes you make.

To change the typeface, choose from the Font list box; the selected font name displays in the text box. The type of 
font (i.e., True Type, Type 1, Bitmap) is noted under the Sample display box. (If selected text contains more than one 
font, the text box appears blank.)

Control Strip 

To change the character size, choose from the Point Size list box or type in the desired value (4-127); the selected 
size displays in the text box. (If selected text is assigned more than one point size, the text box is blank.)

Control Strip 

You can apply any combination Style options: bold, italic, underline, and/or all caps.
To toggle a style on or off, click its respective check box.

denotes that the style is turned off
denotes that the style is turned on
denotes that text is selected and some of the characters have the style turned on and some of the 

characters have the style turned off. 
First click turns the style on for all the selected text.
Second click turns the style off for all the selected text.
Third click returns that style to its original state. 

   Control Strip 

CTRL+B, CTRL+I, CTRL+U
Click OK to close the dialog box and apply your changes.



Paragraph Dialog Box
 Format/Paragraph… (ALT+O,P)  

 CTRL+SHIFT+P
This dialog box lets you modify the paragraph attributes for the current or selected paragraph(s).

Paragraph Attributes
Indents dictate the amount of horizontal space to indent the paragraph(s) in relation to the left or right margin. A zero 
indent means that the text is aligned with the margins.

Left amount of space to indent the left side of the paragraph(s) from the left margin.
Right amount of space to indent the right side of the paragraph(s) from the right margin.

First amount of space to indent the first line of the paragraph(s) from the left indent.
Spacing dictates the amount of vertical space to use before and after paragraph(s) and the space to use between 
the lines in each paragraph.

Above amount of space to add before the first line of paragraph(s).
Below amount of space to add after the last line of paragraph(s).
Leading amount of space to use between lines of text in each paragraph, specified as a percentage of the nominal 
line spacing (e.g., 100 = normal; 200 = double-spaced).

Note: You can choose a Leading value from its drop-down list or type in your own percentage (values from 
50% to 300% are valid).

Alignment determines how to align the paragraph(s).

Left
aligns text with the left margin, creating a ragged right edge.

Right
aligns text with the right margin, creating a ragged left edge.

Center
centers each line between the left and right margins, creating ragged edges on both sides.

Justify
adjusts spacing between words in selected and new paragraphs so that the paragraph(s) is flush with both the left 

and right margins.
To avoid large amounts of white space between words in narrow columns, turn hyphenation on (see below).

Hyphenation determines if and how often the paragraph(s) use automatic hyphenation.
None turns automatic hyphenation off (default); no lines are automatically hyphenated.

Adjacent Lines every line can be hyphenated.
2 Line Separation every other line can be hyphenated.

3 Line Separation every third line can be hyphenated.
Borders determine if and what kind of borders the paragraph(s) will have.
Note:  Border specifications are always measured in points (1 point = 1/72 inch).

Type determines the placement of borders; choose from the drop-down list.
Thickness dictates how thick the borders are; click on one of the four preset thickness boxes or enter another value
in the Thickness text box.

Separation specifies the amount of white space to insert between each border and the paragraph text.

Paragraph Options and Commands
To modify paragraph attributes, type in a different value in any of the Indents or Spacing text boxes, choose a 

different Alignment or Hyphenation, and/or specify Borders settings.
To create a hanging indent (first line is closer to or at the left margin), enter a negative value in the First text box; 

enter a greater than or equal to positive number in the Left text box.
To modify default character attributes for the paragraph(s), click Character… to access the Character dialog box.
To select paragraph bullet options, click Bullet… to access the Bullet dialog box.



Bullet Dialog Box
This dialog box lets you set bullet options for paragraphs.
Note:  Except for Horz. Pos which is measured in inches, bullet specifications are always measured in points (1 point 
= 1/72 inch).

Type indicates if and what style paragraph bullets are used.
None removes any bullets from every paragraph.
Round uses a  symbol.

Diamond uses a  symbol.
Character uses the ANSI character you specify (see below).

To use Round or Diamond bullets, click on one of the standard (3.0-7.0 pt) size boxes or enter your own point size 
in the respective Size text box. The chosen Type changes to reflect your selection.

To use Character bullets…
1. Choose the desired Font from the drop-down list. The chosen Type automatically changes to 'Character.'
2. Type the ANSI # of the character you want to use, or use the up and down scroll arrows. The corresponding 

character displays in the Symbol display box.
3. Type the desired Pt Size for the selected character or choose from the drop-down list.

Positioning Bullets
The position of bullets is dictated by the Horz. Pos and Vert. Pos values.

Horz. Pos amount of space to insert between the bullet and the left edge of the paragraph.
Vert. Pos amount of space above or below the text's midpoint to place the bullet.

Zero = at the midpoint
Negative # = below the midpoint
Positive # = above the midpoint

To modify the default position of bullets, enter new value(s) accordingly.
Click OK or press ENTER to return to the previous paragraph settings dialog box.



Utilities Menu
Use the Utilities menu commands to customize your Instant Resume environment and help you improve your resume
or contents.

Spell Check… (F9)
Scans your resume for unknown or misspelled words. You have a choice of scanning the resume from the 
current cursor position or from the beginning. If the spell checker does not find any questionable words, a 
message box displays. If Instant Resume finds a questionable word, the word displays in the Spell Check dialog 
box.

Action Words… (CTRL+SHIFT+F9)
Opens a separate Action Words window, which lists words you can copy onto the clipboard and then paste into 
your resume for more impact or variety of wording. You can move and resize this window, which you can leave 
open as you create and edit your resume.

Verify Dates… (F5)
Scans the chronological sections of a resume for questionable date entries. If the scan does not find any 
questionable dates, a message box displays. If Instant Resume detects a possible error, it displays the Verify 
Dates warning box, which lets you change or ignore the detected error.

Position Layout Bar… (CTRL+SHIFT+L)
Accesses the Position Layout Bar dialog box from Instant Resume, which lets you reposition the Layout Bar.
   Double-click any blank area on the Layout Bar to access the Position Layout Bar dialog box.

To display a hidden Layout Bar, press ALT+SHIFT+L.
Customize QuickButtons… (CTRL+SHIFT+Q)

Accesses the Customize QuickButtons dialog box, which lets you add and delete command buttons, from a 
predefined list, to and from the QuickButtons and choose where to position them on your screen.
   Double-click any blank area on the QuickButtons strip to access the Customize QuickButtons dialog box. 

When QuickButtons are a floating palette, double-click on the Title Bar.
To toggle the display of QuickButtons on and off, press ALT+SHIFT+Q.



Click OK to close the message box.



Click OK to close the message box.



Spell Check Dialog Box
 Utilities/Spell Check… (ALT+U,S)  

 F9
This dialog box displays if the spell checker finds an unknown or misspelled word. With this dialog box, you can 
optionally correct, ignore, and/or add the unknown word to a separate user dictionary (saved as USER.DIC in the 
directory where you installed Instant Resume).
When the spell checker finds an unknown or misspelled word, it checks the Instant Resume dictionary for possible 
corrections. As it searches the dictionary, the status line (bottom right of the dialog box) displays 'Searching…' and 
'Suggesting….' Wait until the search is over, indicated by 'No more suggestions,' before making any selections.

Spell Check Information
The first line in the dialog box displays the Word that is not in the Instant Resume dictionary. 
The Suggested Words box lists possible corrections for the unknown or misspelled word.
The Change To text box specifies the spelling that is to replace the unknown or misspelled word. By default, the first 
suggested word displays in this text box.

To use a different replacement word, click to select another word from the Suggested Words list, or type in your 
own correction in the Change To text box.
Spell Check Commands
Change replaces the word with the text in the Change To text box and continues checking for spelling errors.
Change All replaces all occurrences of the word with the text in the Change To text box and continues checking for 
spelling errors.
Skip continues checking for spelling errors without replacing the word.
Skip All continues checking for spelling errors without replacing the word, ignoring all further occurrences of the 
same word.
Add Word adds the unknown word to the user dictionary.
Undo Last undoes the last substitution that the spell check has made, reverting the word to its original spelling.
Stop ends the Spell Check session and closes the dialog box. You can end the spell check at any time.

A message box displays when the spell checker finishes scanning the resume. 



Click OK to close the message box.



Action Words Window
 Utilities/Action Words… (ALT+U,A)  

 CTRL+SHIFT+F9
This resizable and movable window displays a list of 'action words' and synonyms, which you can use to add impact 
and improve your resume.

Click the respective alphabet letter to jump to that part of the list.

When you move the cursor over an alphabet letter or an action word, the cursor changes to .

To copy a word to the clipboard and close the window, double-click the word. 
To copy a word to the clipboard without closing the window, click the word to highlight it; then click Copy. You can 

then continue browsing through the list.
Click Close to close the window.

To paste the last copied word into your resume at the cursor position, choose Edit/Paste (CTRL+V).



Verify Dates Warning Box
 Utilities/Verify Dates… (ALT+U,V)  

 F5
This warning box displays if the date scan detects a possible date error.

Types Of Date Errors
Invalid Date Text in date field is not in one of several standard date formats. Certain text entries, such as 1990

to Present, and European dates are acceptable formats. Acceptable years include 1900-2100. 
Therefore, invalid dates, such as '1790' are also detected as errors, as well as misspelled text 
items associated with dates. If you include more than one acceptable date format in a section, 
the second type is flagged as invalid, so that the date formats within resume sections are 
consistent.

Time Gap A time gap exists in a chronological section of the resume.
Overlapping dates and dates not in reverse chronological order are also flagged.

Warning Information
Warning displays a brief description of the error type.
Current Date/Previous Date/ Date Field displays the text from your resume that caused the warning, or the first of 
two dates causing a time gap warning.
Suggested Replacement/Next Date displays, whenever possible, a suggested correction for the error, or the second
of two dates causing a time gap warning. Type in your own correction as needed.

Date Commands
Change corrects the flagged error by replacing the Current Date contents with the Suggested Replacement 
contents and continues scanning the resume. In the case of Previous Date/Next Date, it changes both as you have 
specified.
Skip ignores the warning and continues scanning the resume.
Stop ends the verification process and closes the dialog box.

A message box displays when the date checker finishes scanning the resume.



EXAMPLE: March 90 to June 92
August 92 to January 93
(month of July 92 not accounted for)

Blank date fields under Experience or Education are also flagged as date errors.



Position Layout Bar Dialog Box
 Utilities/Position Layout Bar… (ALT+U,L)  

 CTRL+SHIFT+L
Double-click any blank area on the Layout Bar to access the Position Layout Bar dialog box.

This dialog box lets you change the location for displaying the Layout Bar.

To Position… Choose…
Horizontally, at the top of the 
document window

Top (default)

Horizontally, below the horizontal
scroll bar

Bottom

Vertically, on the left side 
beneath the document window 
Control Menu box

Left

Vertically, on the right side, next 
to the vertical scroll bar

Right

Click Close to save the setting.



Keyboard Guide
Click a topic for using the keyboard in Instant Resume.

Using Menus
Working with Dialog Boxes
Working with Text
Menu Shortcut Keys



Menu Shortcut Keys

Menu Command Shortcut Key
File New… CTRL+N

Open… CTRL+O
Close CTRL+F4
Save CTRL+S
Save As… F12
Page Setup… CTRL+W
Print… CTRL+P
Printer Setup… CTRL+Q
Exit Instant Resume ALT+F4

Edit Undo/Redo CTRL+Z
Cut CTRL+X
Copy CTRL+C
Paste CTRL+V
Find… F7
Replace… F8
Find Next/Replace Next… F3
Add Section… CTRL+A
Delete Section.../Delete 
Subsection...…

CTRL+D

Insert Header ALT+SHIFT+H
Insert Page Number ALT+SHIFT+I

View Actual Size CTRL+1
Fit Page In Window CTRL+9
Fit Margins In Window CTRL+8
200% CTRL+2
75% CTRL+7
50% CTRL+5
Show Layout Bar ALT+SHIFT+L
Show Control Strip ALT+SHIFT+C
Show Status Strip ALT+SHIFT+S
Show QuickButtons ALT+SHIFT+Q

Format Global Character… CTRL+G
Section Character… CTRL+H
Section Paragraph… CTRL+SHIFT+H
Character… CTRL+SHIFT+C
Bold CTRL+B
Italic CTRL+I
Underline CTRL+U
Paragraph… CTRL+SHIFT+P
Left CTRL+L
Right CTRL+R
Center CTRL+M
Justify CTRL+J
Insert/Delete Page Break CTRL+ENTER

Utilities Spell Check… F9
Action Words… CTRL+SHIFT+F9
Verify Dates… F5
Position Layout Bar… CTRL+SHIFT+L
Customize QuickButtons… CTRL+SHIFT+Q




